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Chapter 1. Introduction  

This chapter presents introductory information to be reviewed prior to unpacking your Cellometer® K2 instrument. 
It includes a product overview, lists contents of shipping container, identifies symbols/abbreviations used on both 
the device label and instrument, and provides a summary of topics contained in this user manual. 

CELLOMETER K2 MATRIX SYSTEM OVERVIEW 

Cellometer® Automated Cell Counters incorporate the basic principles of Imaging Cytometry traditionally used in 
manual cell counting via hemocytometer into a suite of instruments designed to simplify the cell counting process. 
By capturing multiple images of cells to be counted, users can adjust parameters based on cell morphology and 
perform reanalysis as necessary. Cellometer Counting Chambers are equivalent to all four corner squares of a 
hemocytometer and are disposable, thus saving time and effort, and eliminating any risk of cross-contamination. 

Using both Brightfield and Dual-Fluorescent imaging in combination with pattern-recognition software, the 
Cellometer K2 quickly identifies cells and accurately calculates Cell Count, Mean Diameter (micron) and Cell 
Concentration (cells/mL). Customizable cell type parameters are designed to assist in the declustering of clumpy cell 
lines. For cultured cells stained with trypan blue or fluorescent reagents, the K2 simultaneously calculates Live/Dead 
and Total cell counts, Viability (%), and Live and Total cell concentrations, including a helpful graphic overlay used to 
highlight live and dead cells with color-coded outlines in the image being viewed. 

The minimal footprint of the Cellometer K2 is designed to fit into small lab spaces and the Matrix software can be 
loaded onto computers that meet specified requirements. With an Operating Computer connected to the 
instrument via USB cable, the system can be linked to a network for accessing external files, printers and storing 
count results. An optional Matrix 21 CFR Part 11 module ensures the integrity of your data by limiting access to 
authorized users, retaining an audit trail of user transactions, offering electronic signing/unsigning capabilities and 
providing multi-layer access control via user roles. 

Intended Use 

Intended use of the Cellometer K2 is to count cell lines and primary cells (e.g., total nucleated cells, PBMCs, 
splenocytes, hepatocytes, stem cells, tumor/tissue digests, etc.) with the ability to determine cell count, viability 
and additional analysis using trypan blue exclusion or fluorescent reagents.  

Personnel operating this instrument are encouraged to familiarize themselves with device controls and operation. 
Ensure that users can identify all components associated with the instrument, perform adequate adjustments and 
understand performance criteria. If issues are encountered, see Troubleshooting and Instrument Messages on page 
47 to restore performance if instrument does not meet or exceed defined performance criteria. 

WARNING: Use of controls or adjustments or performance of procedures other than those specified 
herein or by Revvity, Inc. may result in a hazardous process. 
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CONTENTS OF SHIPPING CONTAINER 

Cellometer K2 Instrument 

Instrument Power Supply/Power Cord (Figure 1)  

USB 2.0 Connector Cable (Figure 2) 

USB Drive (Figure 3) 

Contains Matrix software and PDF files listed below 
Store USB drive where it can easily be located if 
software needs to be installed on another computer. 

Cellometer K2 Matrix User Manual (PDF file on USB/Laptop − this document) 

Matrix Software User Manual (PDF file on USB/Laptop) 

Cellometer K2 Matrix Quick Start Guide (PDF file on USB/Laptop  
and provided as printed copy with instrument) 

Cellometer K2 Focus Guide 

 Graphic sheet to help users with adjusting instrument focus 

Counting Chamber Slides (Figure 4)  

One box of 75 disposable slides; each slide contains 
two separate counting chambers 

AO/PI Viability Reagent (CS2-0106-S) 

Starter Kit containing Fluorescent Beads and two SD100 slides 

Revvity-provided Laptop (Figure 5) with Power Supply/Power Cord 

Optional. If a Laptop (also referred to as Operating Computer)  
was purchased from Revvity with the instrument, it will be 
shipped in a separate box. 

 

MATRIX SOFTWARE OVERVIEW 

The Matrix software used to run the Cellometer K2 is shared by multiple product families and includes default 
assays (identified with MX_, PLX_ or K2_ prefixes indicating the intended instrument) and report templates for all 
supported product types. However, only assays available for the Cellometer K2 will be displayed when entering 
setup details, and report templates will be adjusted dynamically for presentation based on scan results. Assays and 
report templates for all product types can be viewed in the Manage tab > Assays and Report Templates screens. 

Key elements in Matrix software functionality are described below: 

• Acquiring Sample Data − The Acquire tab > Setup and Preview options are sequential screens used to acquire 
sample data. After loading samples, entering setup details, selecting at least one well and then clicking the 
Preview button, you can preview live channel images and adjust instrument focus/fluorescent exposure for 
each channel. Clicking the Count button engages the camera to acquire sample images as specified by the 
selected assay, which are then processed by the Matrix imaging and pattern-recognition software to decluster, 
identify and count individual cells according to defined cell type parameters. 

    Figure 3. USB Drive 
 

 

Figure 4. Counting Chamber Slides 

         Figure 5. Laptop 

Figure 1. K2 Power Supply/Cord 
 

Figure 2. Connector Cable 
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• Analyzing Scan Results − The Data tab > Select, Results and Recount options are sequential screens used to 
analyze scan results. Once a result is selected, you can vary the image displayed by clicking available channel 
buttons (e.g., BR, FL1, FL2, etc.) appearing across the top of the Well View tab or by choosing another well. 
Data associated with the well appears below the image or can be viewed as a consolidated report including 
data from all wells by clicking the Summary tab. To fine-tune the analysis of a scan, click the Recount button 
and either select a new assay or click the View button for the current assay to edit parameters as necessary. 
Last Used Assay parameters are provided for your reference. 

• Setting Up Auto Exports − The Matrix auto export feature allows you to select the Images (e.g., Raw Images and 
Colorized Images), Data (e.g., Well Level CSV, Object Level CSV and Object Level ACS) and Archive (e.g., Data Set) 
output file types to be exported for an assay after completion of scan analysis. In addition, ACS templates can 
be imported into the Matrix software and assigned to an assay. On export, data will auto populate into the 
specified ACS template and can launch FCS Express if the Auto Open option is also selected. 

• Customizing Reports − The Matrix custom reporting feature allows you to assign and/or modify report 
templates to be used by assays when generating scan results. You can change the report template used for 
displaying Well View tab data and manage the Reports List associated with an assay. You can also enable up to 
five additional tabs or specify output file types (e.g., CSV, Excel, PDF and Word) to be automatically exported, 
opened or printed after completion of scan analysis. 

• Managing Assays, Cell Types, ACS Templates and Report Templates − The Manage tab > Assays, Cell Types,  
ACS Templates and Report Templates options display lists of these entities currently loaded in your instrument 
system. From these screens you can import/export, rename, delete or show/hide an entity in its applicable list. 
For most entities you can also view, create or use locked entities as templates to create new ones. 

Matrix Screen Elements on page 22 and Matrix Counting and Analysis Workflow on page 33 are the only sections in 
this manual that reference using the Matrix software. See the Matrix Software User Manual for a full description 
of Matrix software functionality. 

MINIMUM COMPUTER REQUIREMENTS 

If a customer-supplied Operating Computer is set up to run the Cellometer K2 instrument powered by the Matrix 
software, it must meet the following minimum requirements: 

• Windows 10 PC, 64-bit 
• Intel® Core i7, 2.0 GHz processor 
• 16 GB RAM  
• USB 2.0 Port 
• GPU NVIDIA P1000 (or equivalent) 
• Full HD Display Resolution: 1920 x 1080 pixels 

In addition, these requirements apply to any alternative computer (e.g., workstation or personal laptop) used to run 
the Matrix software in Data Analysis mode (i.e., while not connected to an instrument). Scan results can easily be 
exported from the Operating Computer and imported onto an alternative computer for re-analysis.  
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MATRIX 21 CFR PART 11 MODULE OVERVIEW 

The Matrix software offers a 21 CFR Part 11 module that is compliant with the Code of Federal Regulations (CFR) 
Title 21 Part 11 − Electronic Records: Electronic Signatures published by the U. S. Food and Drug Administration 
(FDA). In summary, this module ensures that an organization’s use of electronic records and digital signatures in 
place of traditional paper-based documentation is in compliance with current FDA regulations.  

Key elements in Matrix 21 CFR Part 11 module functionality are described below: 

• Electronic Signatures are captured during the counting and analysis workflow using e-Sign/e-Unsign buttons 
and include the name of an authorized user, date/time when the signature was executed, reason for the 
action being performed and meaning of the signature (i.e., for the Review, Approval or Rejection of an action). 
If a user’s assigned role does not have permissions to approve count results, a supervisor can log in to e-Sign 
the record on behalf of the user. 

• Electronic Records are created as the result of linking electronic signatures to user actions ensuring that 
records have not been copied or falsified in any manner.  

• An Audit Trail provides assurance regarding the integrity of an electronic record and continually monitors all 
users performing actions, the type of actions performed, and the date/time associated with user actions.  

This module may be enabled for your instrument at time of purchase or implemented as an upgrade in the field by 
Support. See the Matrix Software User Manual for a full description of Matrix 21 CFR Part 11 module functionality. 

ABOUT THIS USER MANUAL 

This Cellometer K2 Matrix User Manual provides information on the following topics: 

• Instrument System/Software Overviews • Matrix Counting and Analysis Workflow 

• Hazards, Safety Info and Environment • Cleaning, Maintenance and Storage 

• Components, Device SN Label and Specs • Troubleshooting, Messages and FAQs 

• Unpacking and Site Preparation  • Contacting Support and Reporting Issues 

• Installation, Operation and Screen Elements • Consumable Slides, Reagents and Beads 

• Comparison of Viability Methods • Report Designer for WPF Reference 

• Sample Preparation • Warranty and License Details 

 

  



 Chapter 1. Introduction 

8003393 Cellometer® K2 Matrix User Manual Rev E  5 

The following Precaution Signifiers are used in conjunction with the  symbol in this user manual:  

IMPORTANT: Note indicating that to skip or move past <content_of_note> may result in  
improper functionality of the instrument. 

CAUTION: Note indicating that <content_of_note> may damage instrument to the point where  
it will no longer function as expected. 

WARNING: Note indicating that <content_of_note> may permanently damage instrument  
and cause personal injury or harm. 

GLOSSARY OF ABBREVIATIONS 

The following abbreviations may be displayed on the shipping container, on the Cellometer K2 device label or in this 
user manual. 

A Amperes kW Kilowatt 

AC Alternating Current lb Pound 

ANSI American National Standards Institute PC Personal Computer 

AO Acridine Orange PI Propidium Iodide 

API Application Program Interface LED Light-emitting Diode 

@ at MHz Megahertz 

BR Brightfield µg Microgram 

°C Degrees Celsius µL Microliter 

cm Centimeter µm Micron (Micrometer) 

EU European Union mL Milliliter 

°F Degrees Fahrenheit mm Millimeter 

FCC Federal Communications Commission  ms Millisecond 

FDA Food and Drug Administration  nm Nanometer 

FL Fluorescence OQ Operational Qualification 

GUI Graphical User Interface OSHA Occupational Safety and Health 
Administration 

Hz Hertz P/N Part Number 

IFU Information for Use SN Serial Number 

in Inch SW Software 

IPA Isopropyl Alcohol US United States 

IQ Installation Qualification USB Universal Serial Bus 

kg Kilogram V Volts 

kHz Kilohertz WEEE Waste Electrical and Electronic 
Equipment 
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GLOSSARY OF SYMBOLS 

The following international symbols may be displayed on the shipping container, on the Cellometer K2 device label 
or in this user manual. 

 

Keep Dry. Located on 
Shipping Container 

 

This End Up. Located on 
Shipping Container 

 

Fragile, Handle with Care. 
Located on Shipping 
Container 

 

FCC Part 15 Supplier 
Declaration of Conformity. 
Located in User Manual 

 European Conformity Mark. 
Located on Device SN Label 

 
ISO 9001 Certified 
 

 
Polarity DC Power 
Connector. Located on 
Device SN Label 

 NRTL Safety Mark. Located 
on Device SN Label  

On − Power Connection to 
Mains. Located on 
Instrument Power Switch 

 

Waste Electrical and 
Electronic Equipment 
Directive (WEEE). Located 
on Device SN Label 

 Korean Certification for  
EMC Directives and 
Registration Number. 
Located on Device SN Label  

Off − Power Disconnection 
from Mains. Located on 
Instrument Power Switch 

 Serial Number. Located on 
Device SN Label 

 UK Conformity Assessment 
Declaration of Conformity to 
UK Directives. Located on 
Device SN Label 

 Manufacturer. Located on 
Device SN Label 
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Chapter 2. Hazards, Safety and Environment 

As with any equipment that involves moving parts, there are potential hazards involved in the operation and 
maintenance of this instrument. This chapter identifies potential hazards, lists equipment safety information and 
provides environmental requirements. 

POTENTIAL HAZARDS 

This section describes instrument safety features designed to minimize potential hazards. Before using the system, 
familiarize yourself with this information. 

WARNING: No modification of this equipment is allowed. Modification of equipment can  
result in improper operation causing possible injury. 

In the United States, the facility operating the instrument should follow all OSHA Manual lines  
and applicable ANSI standards for the safe use of this instrument.  

Customer and operator agree that it is their sole responsibility to fully understand and comply  
with local, state, and federal laws, rules and regulations in the use of this system. 

Cables and accessories not specified within the instructions for use with this instrument are not 
authorized. Using other cables and/or accessories may adversely impact safety and performance. 

Note: The Cellometer K2 instrument should not be used adjacent to or stacked with other equipment unless 
specified by Revvity. If the system must be used adjacent to or stacked with other equipment, then observe the 
instrument in its configuration to verify instrument operation is normal and functions as expected. 

Electrical Hazard 

No part of the exterior housing should be removed. Do not open the instrument cover. For assistance, contact 
Support by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

WARNING: To avoid the risk of electrical shock, this equipment must only be connected  
to a grounded electrical outlet. 

In addition, ensure electrical supply plug is not obstructed and can be reached by users  
to disconnect the device if necessary. 

  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Instrument System Hazard 

Read the instructions, warnings and cautions provided with the instrument before using. 

 

WARNING: Inspect instruments and cables for breaks, cracks, nicks and other damage before 
every use. This may be done visually under magnification or with a high voltage insulation 
testing device. If damaged, do not use. Damaged instruments or cables may result in injury 
to the user. 

 

CAUTION: The instrument is designed to accept only one slide at a time. Do not attempt  
to load more than one slide into the sample slot. Doing so will cause an error and could 
damage the instrument. 

 

CAUTION: Do not stack equipment on top of the Instrument or place Instrument on top  
of electrical equipment. This is an unstable configuration and does not allow for  
adequate cooling. 

In addition, it is recommended that as much distance as possible be provided between the 
instrument and any equipment emitting a high vibration signature. High levels of vibration  
may affect clarity of the image being viewed. 

 

WARNING: Do not remove the instrument cover. For assistance, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

Servicing Hazard 

No one other than Revvity-authorized personnel may service inside the protective cover of the Cellometer K2 
instrument.  

CAUTION: Do not pull the system by the connectors. Toppling of the system or causing damage  
to the system may result in the instrument no longer functioning as expected. 

  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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SAFETY INFORMATION 

Personnel operating and maintaining the Cellometer K2 instrument should be familiar with the safety information 
included in this section.  

Safety Protocols 

Revvity assumes no liability whatsoever for any damage, loss or injury resulting from an application of a product 
that is not in strict accordance with the instructions provided with the product. Revvity also assumes no liability for 
any damage or injury arising as a result of operator error or mistake, including, but not limited to, injury arising 
from operator’s lack of qualification or as a result of errors or mistakes committed by such operator.  

Read all installation and operation instructions contained in this user manual thoroughly before connecting the 
Cellometer K2 instrument to the main power connection prior to use. The Cellometer K2 must be set, regulated 
and used in accordance with instructions outlined in this user manual. Failure to observe safety warnings and 
precautions may present a risk.  

Only individuals with appropriate safety training and knowledge should operate, assist in the operation of, or 
perform cleaning and routine maintenance of this instrument. Only the operator should be responsible for system 
controls during a procedure.  

Safety Features 

The Cellometer K2 instrument offers several safety features to prevent its misuse or unintentional activation. All 
personnel who operate the system should be familiar with these safety features. 
 
For assistance, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

 

Federal Communications Commission 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference and (2) this device must accept any 
interference received, including interference that may cause undesired operation. 

 
  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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ENVIRONMENTAL REQUIREMENTS 

Environmental requirements for intended operation of the Cellometer K2 instrument are presented below. 

− For Indoor Use Only 

− Elevation: 0 to 2,000 m 

− Temperature Range: 10 °C to 30 °C 

− Relative Humidity: 0% to 90% RH, non-condensing 

− Pollution degree: Degree 2 

− MAINS supply voltage fluctuations up to ± 10% of the nominal voltage 

IMPORTANT: If the equipment is used in a manner not specified by the manufacturer,  
the protection provided by the equipment may be impaired. 

 



 

8003393 Cellometer® K2 Matrix User Manual Rev E  11 

Chapter 3. Instrument Description 

This chapter describes the Cellometer K2 instrument components, device label and system specifications. 

CELLOMETER K2 COMPONENTS 

Sample Slot: Counting chamber slides are inserted into this slot for viewing (accepts only one slide at a time).  

Focus Knob: Radial dial used to focus the camera. 

Power Switch: Controls power going to the instrument. 

USB 2.0 Port: Port used to connect Cellometer K2 to Operating Computer with Connector Cable provided. 

Power Supply Input: Port used to connect the Power Supply/Power Cord to the instrument.  

Device Label: Lists the instrument serial number (SN), model, manufacturer and input power requirement.  

DEVICE SN LABEL  

 

UK Conformity Assessment Declaration 
of Conformity to UK Directives 

 

   

 Korean Certification for EMC Directives 
and Registration Number 

 European Conformity Mark 

 
NRTL Safety Mark 

 
Waste Electrical and Electronic 
Equipment Directive (WEEE) 

                                               
Polarity DC Power Connector 
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INSTRUMENT SPECIFICATIONS 

The Cellometer K2 Matrix System is comprised of instrument connected via USB cable to an Operating Computer 
used to run the instrument software. The Operating Computer can be linked to a network for accessing external 
files, printers and for storing count results. 

 Cellometer K2 

Channels Brightfield and Fluorescent (FL1 - Green and FL2 - Red) 

Fluorescent Optics 

VC-535-403 
Excitation / Emission: 

 

470 nm / 535 nm 

Example Fluorophores: 
 

- Acridine Orange (+DNA) 
- CFDA 
- FITC 

VC-660-503 
Excitation / Emission: 

 

540 nm / 605 nm 

Example Fluorophores: 
 

- Propidium Iodide 
- Ethidium Bromide 
- 7-AAD 

Commonly Used  
Compatible Dyes AO/PI, Trypan Blue 

Counting Speed (Per Sample) <30 sec 
Volume (Per Chamber) 20 µL 

Cell Size/Diameter Range 4 – 90 µm 
Concentration Range 1x105 – 1x107 cells/mL 

Weight 23 lbs (10.4 kg) 
Width 6.0″ (15.2 cm) 
Depth 8.5″ (21.6 cm) 
Height 14.0″ (35.6 cm) 

Input to Power Adapter 100-240 VAC, 50/60 Hz, 1.0 A 

Output to Instrument 12 VDC, 3.34 A 

The Cellometer K2 uses brightfield and fluorescent imaging with pattern-recognition software to quickly and 
accurately decluster, identify and count individual cells. 

DECLARATION OF CONFORMITY 

Cellometer K2 conforms to appropriate country standards and governing regulations as listed in the  
Declaration of Conformity. To request the K2 Declaration of Conformity, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

https://www.revvity.com/contact-us
mailto:CellC-support@revvity.com
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Chapter 4. Unpacking and Site Preparation 

This chapter presents site preparation facility requirements for setting up the Cellometer K2 and transporting 
instructions if the instrument must be moved to another location. 

UNPACKING/SETTING UP THE INSTRUMENT 

Congratulations on your purchase of one of the best declustering cell counters available! Please ensure you have 
secured the space required to set up your new Cellometer K2 (see Facility Requirements on page 15).  

For assistance in setting up the instrument, visit the Cellometer K2 page on our website to for a training video on 
unboxing and getting started.  

Our staff would be happy to help you set up your Cellometer K2. For assistance, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

1. Inspect the package to ensure no damage has occurred during shipping, if applicable.  
Contact Support if damage has visibly affected the instrument. 

2. Ensure the box is facing up (i.e., This End Up symbol is facing in the right direction).  
If not, carefully turn the box right side up. Box will weigh approximately 30 lbs (13.6 kg). 

3. Open the outer box and remove protective packaging.  

4. Remove the Consumables box and carefully open to locate any temperature-controlled  
beads/reagents. Store the beads/reagents per the product insert provided. 

5. Remove instrument accessories (e.g., Power Supply/Cord, USB 2.0 Connector Cable,  
USB Drive, Cellometer K2 Focus Guide, printed version of Cellometer K2 Matrix Quick  
Start Guide as well as any other documents) and set aside.  

Note: USB Drive will be included only if instrument is not shipped with a Laptop (also referred to as 
Operating Computer). If a Laptop was purchased from Revvity, it will be shipped in a separate box. 

6. Remove the Cellometer K2 instrument and place it in the prepared area 
(see Facility Requirements on page 15).  

7. Remove the protective plastic from around the Cellometer K2. 

8. Connect the instrument Power Supply to the instrument Power Cord. 

9. Connect the instrument Power Supply to the Cellometer K2 and then plug the instrument Power Cord into a 
surge protector (recommended) or dedicated electrical outlet.  

10. If an Operating Computer (Laptop) was purchased from Revvity with the instrument, open the laptop box 
(shipped separately) and set up laptop within reach of the Cellometer K2. The USB 2.0 Connector Cable must 
reach the laptop while it is connected to the instrument.  

− Connect the laptop Power Supply to the laptop Power Cord.  

− Connect the laptop Power Supply to the Operating Computer and then plug the laptop Power Cord into 
an electrical outlet. 

− Power on the Operating Computer and wait for it to initialize 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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11. Connect the Operating Computer to the Cellometer K2 using the USB 2.0 Connector Cable.  

12. Turn the Cellometer K2 Power Switch to the ON position. Power Switch is located on back of instrument. 

13. Confirm that light on front of instrument (under Sample Slot) is lit. The system is now ready for use. 

Cellometer K2 IQ/OQ Validation 

Revvity, Inc. has designed an Installation Qualification/Operation Qualification (IQ/OQ) validation specifically for 
the Cellometer K2 Matrix System. Our experienced Support team is available to assist your organization during set 
up of the instrument and while performing the IQ/OQ validation. Contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

21 CFR Part 11 OQ Validation 

If you have enabled Matrix 21 CFR Part 11 module functionality for your system, a separate OQ validation has been 
designed as a supplement to be run in conjunction with the Cellometer K2 Matrix IQ/OQ Protocol.  

Note: Integrating the Matrix 21 CFR Part 11 OQ Protocol Supplement into the Cellometer K2 Matrix IQ/OQ Protocol 
requires that you have purchased a Matrix 21 CFR Part 11 module license and the Cellometer K2-21MX-IQOQ Kit.  

Our experienced Support team is available to assist your organization during set up of the instrument and while 
performing the IQ/OQ validation. Contact Support by visiting https://www.revvity.com/contact-us or send email 
to: CellC-support@revvity.com 

  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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SITE PREPARATION 

Facility Requirements 

Instrument must be plugged directly into a surge protector (recommended) or power outlet. Ensure all cables are 
free from kinks or tangles prior to starting the Cellometer K2. 

Due to how the instrument is used with liquids, the instrument should be placed on a level surface.  

Keep the area around the Cellometer K2 clean between, during and post operation.  

Electrical requirements for the Cellometer K2 are as follows: 

• 1.0 AMP service 
• Wall receptacle voltage between 100 to 240 VAC 
• 50/60 Hz 

 

Note: Voltage requirements vary per region. For international customers, ensure that Power Cord meets local 
regulations or use a suitable replacement. 

Note: The instrument can be disconnected from the mains by disconnecting the Power Cord from the mains plug 
or appliance coupler. 

CAUTION: Do not position the device so that it is difficult to disconnect from power main. 

Transporting the Instrument 

Prior to transporting the instrument by vehicle, disconnect the main from the wall and package all accessories and 
consumables individually and safely, ensuring cables are also protectively wrapped. Refer to instrument 
dimensions to ensure vehicle to be used for transporting meets these requirements.  

When the instrument is loaded into the vehicle, it should be secured in such a way to prevent the instrument or 
components from shifting during transport. 

WARNING: Care should be taken while moving or transporting the instrument to prevent  
damage to the instrument and/or possible injury. 

Disposal of Waste Electrical and Electronic Equipment 

To comply with European Commission Directive on Waste Electrical and Electronic Equipment 
(WEEE) and other country and state regulations, do not dispose of this equipment in any location 
other than designated waste locations. For information regarding proper product disposal,  
contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

 
 
  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Chapter 5. Operation 

This chapter describes installing the software and steps to be performed when using instrument for the first time. 

WARNING: Never place a foreign object inside the Sample Slot (which is designed to accept only  
one slide at a time). Should anything get stuck or spill inside the sample slot, power OFF the  
instrument and contact Support by visiting https://www.revvity.com/contact-us or send email to: 
CellC-support@revvity.com 

INSTALLING THE K2 MATRIX SYSTEM SOFTWARE 

If you purchased a Revvity-provided Laptop with your Cellometer K2 instrument, the Matrix software is pre-installed 
and you can skip this section. Continue to Using Instrument for the First Time on page 21. 

K2 Matrix System software installation consists of multiple steps including Preparing for Installation, Installing the 
Matrix Software, Restoring the Matrix Database and Entering Instrument Details. Once installation is complete, 
additional steps are required when using instrument for the first time such as Connecting Instrument to Operating 
Computer, Launching the Matrix Software, Verifying Instrument and Camera Connections, and Calibrating 
Instrument via the Software.  

Note: Ensure that instrument is not connected to the Operating Computer during installation until specified below. 

Preparing for Installation 

Preparing for installation includes verifying that a customer-supplied Operating Computer meets Matrix software 
minimum requirements and confirming your user account has installation permissions. 

VERIFYING MINIMUM OPERATING COMPUTER REQUIREMENTS 

1. Using the Windows Search functionality , enter  
system information and select the System Information app  
from the Best Match area. The System Summary page is 
displayed by default (shown on next page). 

2. Confirm that Operating Computer meets or exceeds Matrix 
software minimum requirements by viewing information 
highlighted in the following sample screens − OS Name,  
System Type, Processor and Installed Physical Memory (RAM).  

  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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3. To identify graphics cards available on the computer, expand the Components section and click Display.  

4. If multiple graphics cards are available, scroll through the list to confirm that a card meets Matrix software 
minimum requirements (i.e., GPU NVIDIA P1000 or equivalent). 

5. To identify USB ports available on the computer, click USB in the expanded Components section. 

6. Close the window by clicking X in upper right corner. 

7. Right-click on the desktop and select Display Settings from the menu displayed.  

8. Using the scroll bar for the right pane, scroll down to  
view Display Resolution. Confirm that 1920 x 1080 is  
the selected resolution. 

Note: If a different resolution is displayed, select  
1920 x 1080 and click Keep Changes. 

9. Close the window by clicking X in upper right corner.  

VERIFYING SOFTWARE INSTALLATION PERMISSIONS 

Verify that your user account on the Operating Computer has software installation permissions (typically requires 
the Administrator privilege). 

Note this procedure will vary based on your installed Windows version. Check with your IT administrator for 
assistance in verifying software installation permissions.  

 

  



 Chapter 5. Operation 

8003393 Cellometer® K2 Matrix User Manual Rev E  19 

Installing the Matrix Software 

If the Matrix 21 CFR Part 11 module is to be enabled (i.e., requires purchase of a license), you must contact Support 
after Matrix software installation is complete for assistance in enabling the module. 

1. Insert USB Drive containing Matrix software into a USB port of the Operating Computer. 

2. Navigate to USB drive and copy the following folders/files to indicated locations: 

− Copy K2 Settings folder and Matrix vN.N_N.N.NNNNN.N folder (where N.N represents version number 
and NNNNN.N is file build number) to the desktop. 

− Copy Matrix_vN.N_N.N.NNNNN.N.bak database file (where N.N represents version number and 
NNNNN.N is file build number) to root folder (e.g., C:). 

3. Open the Matrix_vN.N_N.N.NNNNN.N folder on desktop and in the DISK1 subfolder, double-click the 
MatrixSetup.exe installer file.  

Note: Prior to installing the Matrix software, the installer checks for prerequisites such as C++ and MS SQL 
Server on your system. If the required prerequisites need to be installed, you’ll need to restart your computer 
and then run the MatrixSetup.exe installer file again. 

4. When the Welcome screen for the installer is displayed, click Next. 

5. Click Install. 

6. Click Finish.  

7. Confirm that the Matrix icon appears on the desktop. 

8. Open the K2 Settings folder on the desktop and then copy the 
Configurations folder contained within to the following path: 

<root_folder>/ProgramData/Nexcelom Bioscience/Matrix/vNNN 

where NNN represents version number (e.g., 510 for version 5.1.0).  

9. When prompted with a confirmation message, click the  
Replace files in destination button and close the window. 
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Restoring the Matrix Database   

1. From the Windows Start Menu, expand the  
Microsoft SQL Server Tools 18 folder to launch the  
Microsoft SQL Server Management Studio 18 application. 

2. In the Authentication drop-down, select 
SQL Server Authentication. 

3. Log in using the following credentials − Login: sa  
Password: Cellaca01 

4. Click Connect.  

5. On the left side of the screen, right click on Databases  
and select Restore Database from the displayed menu.  

6. In the Source area, select the Device option and click the … button.  

7. Click the Add button.  

8. Navigate to location in the root folder (e.g., C:) where you copied  
the Matrix_vN.N_N.N.NNNNN.N.bak database file (where N.N 
represents version number and NNNNN.N is file build number).  
Select the file and click OK. 

9. When prompted with a confirmation message, click OK to 
confirm the file and then click OK again to restore the database. 

10. Expand the database tree and verify that the Matrix database 
appears in the list.  

11. Close the window by clicking X in the upper right corner of the screen. 

The K2 Matrix System software installation is now complete. 

Enabling the 21 CFR Part 11 Module 

If the Matrix 21 CFR Part 11 module is to be enabled for your system (i.e., requires purchase of a module license), 
you must contact Support at this point to request assistance in enabling the module. 
 
For assistance, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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USING INSTRUMENT FOR THE FIRST TIME 

If you are accessing the Matrix software from a touchscreen device, you can interact directly with the software GUI 
by tapping gently on screen elements (e.g., tabs, drop-downs or buttons) using a finger or stylus. If you choose to  
use touchscreen functionality, the term “click” as it appears in this guide may be replaced with “tap” interchangeably. 
As an alternative, a USB mouse may also be connected. 

Connecting Instrument to Operating Computer 

1. Connect instrument Power Supply to Power Cord.  

2. Connect instrument Power Supply/Power Cord to the Cellometer K2. 

3. Plug instrument Power Cord into a surge protector (recommended) or electrical outlet. 

4. Turn instrument Power Switch (located on back left) to the ON position. Light on front of until will be lit. 

5. Connect USB Cable to the K2. 

6. Set up Operating Computer within reach of the K2. The USB Connector Cable must reach the computer while it 
is connected to instrument. Power on computer and wait for the software to initialize. 

7. Connect USB Cable to USB 2.0 port on Operating Computer. Be sure that software installation is complete 
before connecting USB Cable. USB driver will be downloaded automatically by the Operating Computer. 

Launching the Matrix Software 

From desktop of Operating Computer, launch the Matrix software by double-clicking the Matrix icon. 

Note: Upon launch of the software the instrument will run through a startup sequence that includes  
connecting to the database and initializing the calibrations. 

If using a customer-supplied Operating Computer, you will be prompted to enter instrument details. 

ENTERING INSTRUMENT DETAILS 

1. From desktop of Operating Computer, double-click the Matrix icon to launch the software.  

2. Enter instrument Serial Number (located on back of unit).  

3. Enter instrument Optics Number (located on back of unit). 

4. Enter instrument Filter 1 (i.e., Optics Module A # located on 
back of unit). 

5. Enter instrument Filter 2 (i.e., Optics Module B # located on 
back of unit). 

6. Click OK. 
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Verifying Matrix Software Version 

1. Click the Home tab. 

2. Click the About Matrix button to display the software version information.  

Verifying Instrument and Camera Connections 

1. Click the Instrument Status  icon (green “thumbs up”) located in the  
upper right corner of the screen. 

2. Confirm that text in the message box displayed indicates the instrument  
and camera are connected to the Matrix software. 

3. Click the icon again to close the message box. 

Calibrating Instrument Prior to First Use 

After initial setup of an instrument, you must calibrate it using the Matrix software prior to first-time use. You will 
be prompted with a message if you attempt to acquire data before calibration has been performed. 

The calibration process takes a background image that will be used to normalize the cell counter for each installed 
filter pair without a consumable counting chamber slide loaded in the instrument. For assistance, contact Support 
by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

MATRIX SCREEN ELEMENTS 

Upon launching the Matrix software you are presented with the Acquire tab > Setup screen by default. Basic 
screen elements are described below. 

Note: If the Matrix 21 CFR Part 11 module has been enabled for your system, users must log in before they can use 
the software. See the Matrix Software User Manual for details on using 21 CFR Part 11 module functionality.  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Header Bar 

The Header Bar visible across the top of the screen is always displayed.  

Functionality of Header Bar elements is described below. 

 Instrument Status Icons: Displayed in the right corner of the Header Bar, indicates 
current instrument status. Clicking this icon displays a message box containing details. 
Click icon again to close message box. 

• The Live Mode icon (green “thumbs up”) indicates that the instrument and 
camera are connected to the Matrix software. 
 

• The Data Analysis Mode icon (red “thumbs down”) indicates that the instrument 
and camera are not connected to the Matrix software. 
 

• The Simulated Mode icon (blue with an “S”) indicates that the instrument and 
camera are running in simulation mode. 

 

Note: Simulated Mode is only available to Revvity Sales/Field Application Scientists to 
demonstrate and test instrument functionality. 

 Assay/Plate Names: Assay name and plate name are added to the Header Bar when 
you proceed to the Preview screen in the count process. 

 

User ID and Logout Button: If the Matrix 21 CFR Part 11 module is enabled, displays 
the identity of the currently logged in user and Logout button. See the Matrix 
Software User Manual for details on using module functionality. 

Navigation Bar 

The Navigation Bar visible on the left side of the screen contains tabs/screen names and is always displayed. 
Functionality associated with each tab is described below. Note that options displayed in the Acquire and Data 
tabs represent screens marking your progression through a sequential process, while options in the Manage tab 
may be individually selected to perform distinct tasks. 

 

Home Tab: Displays the                                                                       logo distinguishing 
the software from earlier versions used to run the instrument system.  

Also contains the About Matrix button which displays software version details and 
global Support hotlines, as well as the Generate Diagnostic Report/Clear All Logs 
buttons used to assist Support with troubleshooting technical issues. See Viewing 
Software Version on page 25 and Generating Diagnostic Reports on page 49. 
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Acquire Tab: Contains the two sequential screens in the Data Acquisition workflow. 
For example, in the Acquire tab you must first enter Setup details before advancing 
on to Preview the sample and confirm focus/fluorescent exposure for each channel. 
As you move through screens in this workflow, the Navigation Bar status is updated 
to display the current screen. 

The Setup screen can be selected as an option if you decide to review your setup 
after previewing the sample. Once you are satisfied and proceed to performing the 
count, the Navigation Bar status is updated to display the Data tab > Results screen. 
See Performing a Cell Count starting on page 33 for more information. 

 

Data Tab: Contains the three sequential screens in the Data Analysis workflow.  
For example, in the Data tab you must first Select a scan result before you can view 
its count Results. You can then perform a Recount by fine-tuning assay parameter 
settings to be used in the analysis to create a new scan result. As you move through 
screens in this workflow, the Navigation Bar status is updated to display the  
current screen. 

The Select screen can be selected as an option if you decide to review other count 
results after viewing the currently selected scan. See Reviewing Count Results 
starting on page 37 for more information. 

 

Manage Tab: Contains the various system lists of assays, cell types, ACS templates 
and report templates used in the Data Acquisition and Data Analysis workflows. 

• In the Assays screen you can view the library of assays available in your system, 
import/export assays, manage the list of assays as well as create new/modify 
existing assay details. 

• In the Cell Types screen you can view the library of cell types available in your 
system, import/export cell types, manage the list of cell types as well as create 
new/modify existing cell type details.  

• In the ACS Templates screen you can view the library of ACS templates available 
in your system, import/export ACS templates and manage the list of ACS 
templates. ACS templates cannot be created or viewed in the Matrix software. 

ACS Templates can be used for populating data into specified formats when files 
are generated on export. If the Auto Open export option is also selected, the  
De Novo Software FCS Express application is launched for viewing the output file.  

• In the Report Templates screen you can view the library of report templates 
available in your system, import/export report templates, and manage the list of 
report templates as well as create new/modify existing template details. 

See the Matrix Software User Manual for details on using Manage tab options. 

If the Matrix 21 CFR Part 11 module has been enabled for your system, a user hierarchy must be established 
requiring the creation of roles that control varying levels of access to functionality available in each of these tabs. 
See the Matrix Software User Manual for details on using Matrix 21 CFR Part 11 module functionality. 
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VIEWING SOFTWARE VERSION 

The Home tab displays the logo for the instrument to which you are connected.  

As the Cellometer K2 instrument can be run using either Cellometer Image Cytometer or Matrix software, the 
                                                                      logo distinguishes the K2 Matrix System from earlier versions.  

The Home tab also contains the About Matrix button which displays Product Information (e.g., software version, 
instrument serial number/firmware version, and camera serial number), and Revvity Contact Information.  

For details on using the Generate Diagnostic Report and Clear All Logs buttons used to assist the Support team 
with troubleshooting technical issues, see Generating Diagnostic Reports on page 49. 

WARNING: Logs may be required to maintain a historical archive. As using the Clear All Logs  
button will permanently remove accumulated logs for the installed Matrix software version, it  
is recommended that you contact IT before clearing logs from your system. 
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Chapter 6. Viability Methods 

This chapter describes how to choose a viability staining method based on the cell sample and selected assay type. 

EVALUATING VIABILITY METHODS 

When evaluating viability methods, it is critically important to use a single aliquot from the stock cell culture to 
perform all testing. The cell sample should be evaluated for concentration on the Cellometer K2 prior to staining. 

Note: Cell concentrations of 1.0 x 105 − 1.0 x 107 cells/mL can be analyzed on the Cellometer K2, with a 
concentration of 1.0 x 106 cells/mL being optimal. 

If comparing the Trypan Blue and AO/PI viability methods, a portion of the sample should be stained with trypan 
blue and another portion stained with AO/PI. Using samples from the same aliquot containing identical cell 
concentrations will result in a more accurate comparison of staining methods. 

Dilution or concentration of a cell sample may be required based on the initial concentration. It is recommended to 
use cell culture media for dilution.  

Using Trypan Blue Viability Method 

Brightfield imaging and the Trypan Blue Viability can be used to determine the number, concentration and 
percentage of live cells for cell lines and cultured primary cells. Brightfield imaging with trypan blue staining is not 
recommended for samples containing debris, platelets or red blood cells. For accurately differentiating nucleated 
cells, fluorescence is required. 

PREPARING A CELL SAMPLE FOR TRYPAN BLUE VIABILITY DETERMINATION  

Invert the tube containing cells ten times (10x) and pipette up and down 10x to generate a homogeneous cell 
sample and reduce cell clumps. Do not shake or vortex the sample as this may damage cell membranes. 

For viability measurement, stain cells by combining 20 μL of cell sample with 20 μL of a 0.2% trypan blue staining 
solution (for a final concentration of 0.1% trypan blue). Gently mix by pipetting up and down 10x. 

TRYPAN BLUE STAINING SOLUTION GUIDELINES 

Use the following trypan blue staining solution guidelines when preparing cell samples for analysis. 

Stain Type Use with Cell Sample Dilution Factor 

Trypan Blue (0.2%) 1:1 2 
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Using AO/PI Viability Method 

Dual-fluorescence methods have been developed to accurately determine nucleated cell concentration and 
viability in primary cell samples containing debris and non-nucleated cells, including platelets and red blood cells.  

In the AO/PI Viability Method, acridine orange (AO) enters all cells and stains their DNA causing nucleated cells to 
fluoresce Green (470/534 Channel), while propidium iodide (PI) only enters dead cells with compromised 
membranes and stains their DNA causing them to fluoresce Red (531/655 Channel).  

• Cells stained with both AO and PI fluoresce Red due to quenching.  
• Live nucleated cells are easily identified in the Green fluorescence channel.  
• Dead nucleated cells are easily identified in the Red fluorescence channel.  

As a result, debris and non-nucleated cells do not interfere with nucleated cell counts when using the AO/PI 
viability method.  

In images captured by Cellometer K2 using the AO/PI viability method, red blood cells (RBCs, marked by red arrows) seen in 
the brightfield image (on left) are not seen in the fluorescent image (in middle), but are clearly identified in the overlay 
image (on right). Only nucleated cells are counted using the AO/PI staining method resulting in a more accurate total cell 
count and percent viability calculation. 

PREPARING A CELL SAMPLE FOR AO/PI VIABILITY DETERMINATION  

Invert the tube containing cells ten times (10x) and pipette up and down 10x to generate a homogeneous cell 
sample and reduce cell clumps. Do not shake or vortex the sample as this may damage cell membranes. 

For viability measurement, stain cells by combining 20 μL of cell sample with 20 μL of AO/PI staining solution. For 
whole blood and other viscous samples, draw sample in and out of the pipette tip at least once prior to transferring 
for staining. Gently mix stained cell solution by pipetting up and down 10x before adding sample to counting 
chamber (CHT4). 
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The table below shows the recommended dilution when preparing cell samples for AO/PI viability analysis and the 
final Dilution Factor to enter into the Matrix software for a variety of sample types. 

Sample Type Preliminary Sample 
Dilution 

Volume of 
Sample 

Volume of 
AO/PI 

Final Dilution 
Factor 

Whole peripheral blood or  
   cord blood 

1:10 20 μL 20 μL 20 

PBMCs following Ficoll separation Not Required 20 μL 20 μL 2 
Mononuclear cells from 
   processed bone marrow 

Not Required 20 μL 20 μL 2 

Tumor digest/Tissue digest Not Required 20 μL 20 μL 2 
Stem cells from CD34+ separation Not Required 20 μL 20 μL 2 

 

AO/PI STAINING SOLUTION GUIDELINES 

Use the following AO/PI staining solution guidelines when preparing cell samples for analysis. 

Stain Type Use with Cell Sample Dilution Factor 

AO (CS1-0108-5mL) 1:1 2 
PI (CS1-0109-5mL) 1:1 2 
AO/PI (CS2-0106-5mL) 
AO/PI (CS2-0106-25mL) 

1:1 
1:1 

2 
2 
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Chapter 7. Sample Preparation 

This chapter describes preparing Cellometer counting chamber slides and loading counting beads/cell samples into 
counting chambers. 

PREPARING COUNTING CHAMBER SLIDES 

1. For SD100 slides, remove protective film from both sides of the slide. PD100 slides are peeled and ready to use. 

Note: It may be difficult to peel protective film from slide. One method is to adhere tape to the top of film and 
then pull tape off (with film attached). Do not touch or write on the clear optical window areas of the slide.  

2. Place the Cellometer disposable counting chamber slide on a fresh Kimwipe. 

3. To prepare two samples at once, label individual counting chambers (e.g., Chamber 1 and Chamber 2) in the 
white margin of each chamber. Take care to ensure the clear portion of the counting chamber is not touched. 

Note: Both chambers of the slide do not need to be loaded with the same sample. Two different 
samples can be used on a single slide.  

  

Top of Slide Bottom of Slide 
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LOADING SAMPLES INTO COUNTING CHAMBERS 

Cellometer counting chamber slides contain two independent chambers manufactured to a precisely controlled 
height. A cell suspension of 20 µL is pipetted into a chamber through its induction port. 

1. To prepare the sample for counting, invert the tube containing your sample 10 times, then pipette up and 
down 10 times. This will help to evenly suspend cells. Do not shake sample as it may damage cell membranes. 

Note: If testing for cell viability (optional), stain the sample using a 1:1 ratio with 0.2% trypan blue (or other 
chosen viability stain) and mix the stain by pipetting up and down 10 times before performing Step 1, above.  

When preparing a sample to test for cell viability, ensure that the trypan blue stock concentration used is 0.2%.  
If stock concentration is 0.4%, it is recommended you dilute it with a balanced salt buffer (e.g., PBS) and filter 
diluted solution with a 0.2 µm filter before adding stain to your sample. 

2. Immediately transfer 20 µL of sample into a counting chamber by pipetting directly onto its induction port. 
There are two counting chambers per slide; each chamber may be loaded with a different sample. 

3. Hold the loaded slide in the white area and take care to stay away from the clear optical windows. 

Load a counting chamber by touching pipette tip to the chamber’s induction port and then slowly pipetting the entire 20 µL 
sample all at once. Capillary force automatically spreads the sample within the chamber. Each counting chamber can hold a 
separate sample as there is no mixing between the two individual chambers on a slide.
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Chapter 8. Matrix Counting and Analysis Workflow  

This chapter presents the basic workflow for counting beads/cells using the Cellometer K2 powered by Matrix 
software, including best practices and tips.  

For a complete reference on using Matrix software functionality, see the Matrix Software User Manual for details. 

PERFORMING A CELL COUNT 

Performing a cell count consists of multiple steps (e.g., Loading the Samples, Entering Setup Details, Setting Auto 
Export Location and Previewing the Samples) before clicking the Count button. 

Loading the Samples 

If you have already prepared and loaded a slide with samples using instructions from Chapter 7. Sample 
Preparation starting on page 31, skip to Entering Setup Details, below. 

1. Power on the Operating Computer and Cellometer K2 instrument. 

2. Remove the protective film from both sides of the slide. PD100 slides do not have this film. See Preparing 
Counting Chamber Slides on page 31 for details. 

3. Slowly pipette 20 µL of cell/bead sample directly onto an induction port. Take care not to touch clear portion of 
counting chambers. See Loading Samples into Counting Chambers on page 32 for details.  

Note: If testing for cell viability, you must stain the sample before loading it into the counting chamber.  
See Trypan Blue Staining Solution Guidelines on page 27 or AO/PI Staining Solution Guidelines on page 29. 

4. Hold prepared slide by white area only and insert the counting chamber containing cell/bead  
sample into Sample Slot of Cellometer K2 until touching the internal stop. The chamber inside  
the instrument will be counted. 

Entering Setup Details 

1. From the desktop of Operating Computer, double-click the Matrix icon to launch the software. 
The instrument will run through a startup sequence that includes connecting to the database and 
initializing the calibrations. 

2. In the Acquire tab > Setup screen displayed upon 
launch of the software, enter a plate name. If a  
plate name is not entered, a date/time stamp will  
be appended to the “New Sample” default (e.g.,  
New Sample 2023/08/25-10:58:09).  

3. Select an assay from the drop-down and confirm the 
assay description displayed.  
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4. To view and/or edit assay details, click the                 button. Clicking the View button automatically updates 
your progression in the Navigation Bar to the Manage tab > Assays option. Click the Back or Save and Back (if 
you have made any changes) button to return to the Setup screen. 

Note: If an assay is locked for editing (i.e., the Category field displays                       or Locked instead of 
Unlocked), users must first click Save As to save it as a new assay before they can edit parameters.  

5. If desired, add a Tag (e.g., to create a time course series for use in custom reporting). In addition, you can 
change the value in the Dilution Factor field to indicate the final dilution factor for the sample.  

6. In the Well Details area, select Plate Type (i.e., slide type)  
used for the sample and the number of Images Per Well  
(i.e., 1, 4 or 8) to be captured during the count. 

The visualization of Images Per Well for the slide depicts the 
selected number of images (i.e., cross-sections of the area in the  
counting chamber or “well”) to be captured during the scan. 

Setting Auto Export Location 

Expand the Auto Export area to identify a Location for automatically saving scan results. Click the Browse button 
and navigate to a folder on your Operating Computer or network to define the default export path. This default 
path will remain the same within the software until it is manually changed.  

In addition, Exports (see descriptions provided below) and output files for Reports (e.g., CSV, Excel, PDF and Word) 
defined for the current assay are displayed. 

Sample Exports include: 

Raw Images  Represents Black and White high-resolution PNG images for each channel in the assay. 

Colorized Images Represents colorized, high-resolution PNG images of all acquired channels. A single 
colorized image represents individual channel images superimposed one on top of another. 

Well Level CSV  Represents well-level data including well name, calculation run, channel, count, mean size, 
etc. for each selected well in Comma Separated Values (CSV) format. 

Object Level ACS Represents object-level data for each well including type, classification, size, circularity, 
area, perimeter, etc. in Image Cytometry Experiment (ICE) format.  

Exported data may be associated with an ACS template and automatically opened for 
viewing in De Novo Software FCS Express (if specified in auto export options for the assay).  
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Object Level CSV Represents object-level data for each well including type, classification, size, circularity, 
area, perimeter, etc. in Comma Separated Values (CSV) format. 

Data Set  Represents a database file containing all images, results, assays, cell types and report 
templates associated with the scan result. A data set is required to reload data for analysis 
or if you need help from Support to optimize assay and/or cell type parameters. 

To manage Exports and Reports defined for the selected assay, click the View button and expand the Reports and 
Exports option. Select Exports by clicking on file type buttons and manage Reports as necessary. Changes to the 
assay can either be saved to the current assay (i.e., any changes made will also be applied to other scan results 
that use the assay) or saved as a copy with a new name. Edited assays can be used for data acquisition. See the 
Matrix Software User Manual for details on editing an assay to manage exporting and reporting options. 

Previewing the Samples 

Once you have completed entering setup details for the samples, click the                    button located at the bottom 
of the Setup screen. The instrument engages its camera for viewing samples and displays the Preview screen. 
Users can view live images of samples in selected wells, preview available channels for Imaging Mode associated 
with the assay, adjust instrument focus and confirm fluorescent exposure for each channel. 

Note: Although the Acquire tab > Preview option appears in the Navigation Bar, you cannot access the Preview 
screen directly as it requires well details entered in the Setup screen. Once you click the Preview button at the 
bottom of the Setup screen, the Navigation Bar is updated to show your progression to the Preview screen. 

PREVIEWING LIVE IMAGES 

In the Wells area, click on highlighted image sections in  
the slide visualization (i.e., representing cross-sections of the  
counting chamber or “well”). As you move from section to  
section, the live image changes per your selection. 

To zoom in/out of an image, move the mouse to hover cursor  
over the viewing pane and turn the scroll wheel or, if using the 
touchscreen, apply universal gestures (e.g., touch center of image 
with two fingers and then spread them apart to zoom in and reverse 
this action to zoom out.) Current Zoom magnification is displayed in 
bottom right corner of the viewing pane.  

To move a zoomed image around, click and drag the image to a new location as needed. 

ADJUSTING FOCUS  

To adjust the focus of the live image being previewed, slowly turn the Focus Knob located on the right side of the 
instrument until cells/beads are in focus.  

Obtaining good focus is key to ensuring accurate cell counts. Once good focus  
has been achieved, the instrument should perform most counting operations 
with only minor adjustments. 
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PREVIEWING CHANNEL IMAGES 

In the Preview area, channels available for viewing (e.g., Channel 1 and Channel 2) are based on the assay Imaging 
Mode. The Channel 1/BR image is displayed by default. Clicking the FL button displays the Channel 1/FL image.  

Note: If only one channel is available, the Preview field channel drop-down will be hidden. In addition, if the  
BR Only Imaging Mode is selected, the FL button will also be hidden. 

To view images for another channel, select it from the Preview field drop-down. Click the FL button to view 
fluorescence in that channel. A sample Channel 2|FL image is shown below.  

When previewing fluorescent images, confirm that FL signal is strong but has a low, dark background. Modify the 
FL Exposure to increase (prolong) or decrease (shorten) the exposure time accordingly.  

Notes:  

• For BR/FL imaging modes, each channel will be associated with two images − Brightfield (BR) and Fluorescent 
(FL). These images are referred to in assay channel mappings as BR1/FL1 and BR2/FL2. 

• When working with assays that have two channels, use the Channel 1/BR image to adjust focus and then select 
the FL image to confirm exposure. For Channel 2, you only need to select the FL image to confirm exposure 
since focus of its paired BR image is adjusted automatically when you performed the task for Channel 1. 

• If FL images are available for both Channel 1 and Channel 2, a slight offset may exist between BR1 and BR2 
images due to the distance the camera must travel. 

Clicking the Count Button 

Once you have completed previewing the live image for the sample, click the  button located at the 
bottom of the Preview screen. The instrument camera acquires sample images as specified by the selected assay 
which are then used by the Matrix Software to calculate count results according to defined cell type parameters. 
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Note: Depending on the number of selected wells/images per well and defined assay parameters, the counting 
process can take a few seconds to up to a few minutes. 

At the start of count processing, the Navigation Bar status is updated to display the Data tab > Results option.  

As the system acquires sample images and calculates count results,  
the colors used to mark the Wells area selection (where the number of 
highlighted areas is based on the Images Per Well value) will change to 
indicate image status (i.e., from Selected to Acquired to Counted) as 
shown in the legend displayed below the slide visualization.  

Area images are displayed in the Well View tab using the assigned 
Display report template to present count results. Additional tabs may 
be enabled for the scan result (e.g., Summary and .csv). Count results  
will be displayed, printed and exported based on report templates  
defined for the assay.  

Well images displayed can be varied by toggling on/off available channel  
buttons (displayed across the top of the viewing area of the Well View tab)  
and enhancing the Zoom magnification. 

To zoom in and out of sample images, move the mouse to hover cursor over the viewing pane and turn the scroll 
wheel. Current Zoom magnification is displayed in bottom right corner of viewing pane.  

When counting of all wells is complete the scan result will be added to the top of the Results List displayed on the 
Select screen. In addition, Reports and Exports output files defined for the current assay are automatically stored in 
the specified location. 

ANALYZING SCAN RESULTS 

When analyzing scan results, a single image is displayed in the viewing pane for the sample well. If an Images Per 
Well value of 4 or 8 was selected, click on the composite image (containing either 4 or 8 images for areas in the 
well stacked on top of each other as was presented in the slide visualization) and drag to view all areas. 

To zoom in/out of an image, move the mouse to hover cursor over the viewing pane and turn the scroll wheel or,  
if using the touchscreen, apply universal gestures (e.g., touch center of image with two fingers and then spread 



 Chapter 8. Matrix Counting and Analysis Workflow 

8003393 Cellometer® K2 Matrix User Manual Rev E  38 

them apart to zoom in and reverse this action to zoom out.) Current Zoom magnification is displayed in bottom 
right corner of the viewing pane.  

To move a zoomed image around, click and drag the image to a new location as needed.  

Understanding Default Report Tabs 

Report tabs initially displayed across the top of the viewing pane are associated with report templates that have 
been assigned to the current assay and are enabled by default to format the presentation of scan result data.  

Although the Well View tab will always be enabled, you can change the report template used for its display. In 
addition, you can disable default report tabs, change current report template assignments and add new tabs to 
meet your reporting needs. See the Matrix Software User Manual for custom reporting details. 

Changing Well View Image Display 

The Well View tab will always be displayed in the Results screen and includes both an image and the associated 
count results for the well. If multiple images were taken (based on your Images Per Well selection), they will be 
stacked on top of each other and consolidated into a single image. Click and drag the image to view other locations 
(or areas) in the well.  

To zoom in/out of the image, move mouse to hover cursor over the viewing pane and turn the scroll wheel or, if 
using a touchscreen, by applying universal gestures (e.g., touching the center of the image with two fingers and 
then slowly spreading them apart to zoom in and reverse this action to zoom out). Zoom magnification is indicated 
in bottom right corner of the viewing pane and can be increased up to 10.00x. 

At the bottom of the Well View tab is a report containing well-level details for the sample. If an Images Per Well 
value of 4 or 8 was selected, the report represents consolidated data from all images.  
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Varying Well View Channels/Counted Overlay Display 

In the Well View report tab displayed by default, the following buttons may be available across the top of the 
viewing pane based on the Imaging Mode defined in the current assay. 

• Click the Brightfield (BR) or Fluorescence (e.g., FL1 or FL2) 
buttons to select/de-select channels used in the image 
display. Channel views are overlaid on top of each other. 

• Click the  button to show/hide the graphic overlay that 
identifies Counted cells by surrounding them with color-
coded outlines. For 2-channel Viability assays, Green is used 
for counted/live cells, Red for dead cells and Yellow for cells 
not counted (e.g., if larger than the specified cell diameter). 

• Click the  button to enable/disable display of Zoom 
magnification in bottom right corner of viewing pane.  
Zoom feature will still be functional even if not displayed. 

Understanding Custom Reporting 

The Matrix custom reporting feature allows you to assign and/or modify report templates to be used by assays 
when generating scan results. You can change the report template used for display of the Well View report (which 
is always displayed) and add report templates to be enabled as tabs or output as specific file types (e.g., CSV, Excel, 
PDF and Word) that can be opened/printed upon report generation.  

Note: Any changes made to Reporting options for an assay will be saved with the assay and applied to all other 
scan results using that assay the next time a recount is performed. 

For example, a custom Growth Curve report tab has been enabled in the scan result shown below. Clicking this tab 
displays data in the format defined by the associated report template (i.e., illustrating calculation of a growth curve 
for a time course series of scan results).  

See the Matrix Software User Manual for custom reporting details. 
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EXPORTING/PRINTING SCAN RESULT DATA 

Verifying Auto Export 

Expand the Exports area in the Results screen to verify that automatic 
exports were completed and click the location link to open folder where 
the exported scan result files are stored.  

In addition, if you defined any output file types (e.g., CSV, Excel, PDF and 
Word) to be generated for assay report templates, you can verify that 
selected file type exports were also completed. 
 

Exporting and Printing Scan Results (Manual Settings) 

To manually select additional export options (images/data) for scan result files as well as generated output files for 
reports, click the Export button located at the bottom of the Results screen. The Export dialog is displayed.  

Confirm the export Location and if necessary update this path by clicking the Browse button, navigating to a folder 
on your Operating Computer or network, and clicking OK.  

Select scan result Images (e.g., Raw Images or Colorized Images), Data (e.g., Well Level CSV, Object Level CSV and 
Object Level ACS) and Archive (e.g., Data Set) file options to be exported to the specified location. Data Sets are 
stored as .SCANRESULT files.  

In addition, for reports associated with the scan result you can select generated output file types (e.g., CSV, Excel, 
PDF and Word) to be exported and indicate if files are to be opened automatically and/or printed upon export. 
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Note: If the Object Level ACS option is selected, the screen expands 
to display if an ACS template has been assigned to the assay and  
offers an Auto Open option after the report is generated. If no ACS 
template is displayed, users can still export object level ACS data 
assuming they have the export privilege. To change the ACS template 
assigned to an assay, users will need to edit the assay.  

For report templates associated with the scan result you can select generated output file types (e.g., CSV, Excel, 
PDF and Word) to be exported and indicate if files are to be opened automatically and/or printed upon export. 

Note: Any changes to export options are applied only when manually exporting scan results (i.e., by clicking the 
Export and Print button) and will not be saved with the assay or scan result. 

PERFORMING A RECOUNT 

If you find it necessary to fine-tune assay parameters after reviewing your data results, click the Recount button 
located at the bottom of the Results screen. The Recount screen is displayed.  

Once you have made any necessary changes (per the options described below), click the Recount button located at 
the bottom of the screen. After a recount is performed, the Navigation Bar returns to the Results screen. 

Refining Assay Details/Selecting New Assay  

In the Recount Details area you can view parameter settings  
for the Last Used assay, select a new assay from the drop-down 
or view the current assay to edit parameter settings to be used 
for the recount. 

Managing Channel Mappings 

Expand the Channel Mappings area to identify Scan Channels and Recount Channels for the Imaging Mode associated 
with the current assay. Performing a recount uses channel mappings as defined by default (i.e., Recount Channels will 
remain in same positions used for the original Scan Channels).  

Note: With the exception of Brightfield Only configurations (i.e., BR1, BR2, etc.), each channel will have separate 
brightfield and fluorescent images as depicted in the mapping indicators (i.e., BR1/FL1 and BR2/FL2).  

To manage channel mappings for use in a recount, click on a mapping indicator and drag it to a new channel. The 
mapping indicator in that channel will swap positions with the one you are dragging automatically. 
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To return channel mappings to the positions they were in when you first expanded the 
Channel Mappings area, click the Reset button followed by Yes to confirm the action. 

If a new assay selected for recount has fewer channels or you edit the assay previously used to reduce the number 
of channels, mappings displayed are updated to reflect available channels. To manage channel mappings for use in 
the recount, click on mapping indicators and drag them to an available position in the Recount Channels area. 

If you drag indicators from Recount Channels to their home Scan Channels locations, a red outline is used to 
highlight empty Recount Channels locations. All Recount Channels must contain an indicator prior to recount.  

Modifying Auto Export Options 

Expand the Reports and Exports area to identify a Location for automatic exports of images/data and generated 
output files for reports. Click the Browse button and navigate to a folder on your Operating Computer or network 
to define the default export path. This path will remain as the default in the software until it is manually changed. 

In addition, Exports (e.g., Raw Images, Colorized Images, Well Level CSV, Object Level ACS, Object Level CSV and 
Dataset) and output file types for Reports (e.g., CSV, Excel, PDF and Word) defined for the assay will be indicated 
with a blue checkmark. 

Note: To modify Report and Export settings displayed, click the View button for the selected assay in Setup Details 
area and expand the Reports and Exports section to update Exports and Reports file types selected. 
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Clicking the Recount Button 

Once you have completed entering recount details for the samples, click the                        button located at the 
bottom of the Recount screen. The Matrix software performs a recount of the scan using the modified parameters 
and displays the new scan result. 

BEST PRACTICES AND WORKFLOW TIPS 

• The Images Per Well field in the Setup screen allows you to specify the number of images to be taken of the 
counting chamber. Choosing 1 image provides a high-level overview of data and provides the fastest counting 
speed. Choosing 4 or 8 images increases the amount of data collected by partitioning the sample into sections 
and averaging the results from all images, thus improving the precision of calculations for statistical analysis 
but requiring more time to obtain count results. Regardless of the number of Images Per Well selected, count 
results are for the entire counting chamber or “well” (i.e., representing an average of the results).  

• While using the Acquire tab, only the Setup screen can be selected as an option if you decide to review your 
setup after previewing the sample. Once you are satisfied and proceed to performing the count, Navigation 
Bar status is updated to display the Data tab > Results screen. 

• While using the Data tab, only the Select screen can be selected as an option if you decide to review other 
count results after viewing the currently selected scan. When a scan result is created for a sample as the result 
of a count, it will be displayed at the top of the Results List. Double-click on any scan result in this list to view it. 
See the Matrix Software User Manual for details on managing scan results contained in the Results List.  

• When viewing scan results, if you find it necessary to fine-tune assay and/or cell type parameter settings and  
re-analyze the data, click the Recount button at the bottom of the Results screen. You can either edit the Last 
Used assay parameters or select a new assay and edit its parameters as necessary to meet your requirements. 
See the Matrix Software User Manual for details on editing assay/cell type parameter settings. 

Note: If you need help optimizing cell type parameter settings, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

• When viewing export results, multiple folders will be created in the export location defined for the scan result 
– a top-level plate_name folder (where plate_name represents the plate name you entered in the Setup 
screen) and a <date_time> subfolder (where date_time represents the date/time stamp of scan images). 
Within this second-level folder are additional folders (i.e., a Plate-Name folder containing scan images and a 
<date_time> folder containing the initial count results). Contents of this <date_time> subfolder will vary based 
on selected export options. Each time you perform a recount on the scan images a new <date_time> subfolder 
is created for the results.  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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• Data analysis features can be enhanced by creating  
tools such as a Sample Adjustment Calculator and  
Cell Size Histogram to be built into report templates.  

See the Matrix Software User Manual for details on 
editing report templates and enabling them as tabs  
to customize scan results.  
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Chapter 9. Cleaning, Maintenance and Storage 

Keeping the Cellometer K2 and its operative area clean between runs, during use and post runs is a best practice 
and prevents contamination. Caring for the instrument and its consumables is also a best practice. 

Note: If using the Cellometer K2 within a biosafety cabinet, cleaning may not be required, or agents and materials 
may be adapted according to BSC system requirements. Please follow all instructions provided by the manufacturer.  

 

CAUTION: Always power the instrument OFF before cleaning as damage to the machine  
could occur.  

CAUTION: Allow for flammable agents used for cleaning or disinfecting to completely  
evaporate before powering the instrument ON.  

CLEANING  

The instrument and any cords/cables can be wiped down using a 70% Isopropyl (IPA) solution. Repeat until the soil 
is no longer visible. Finish with a fiber optic lint-free wipe (e.g., Kimwipes). 

1. Dampen a fiber optic lint-free wipe with IPA. 
2. Use the wipe to rub lightly on the outside of the instrument until it is visibly clean.  
3. Wait for the cleaning agent to evaporate before powering the instrument ON.  

Should something break or be spilled inside the device, power OFF the instrument and contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

Routine Maintenance 

No one other than Revvity-authorized personnel may service inside the protective instrument cover of the 
Cellometer K2. Contact Support or an authorized service representative to address any changes in instrument 
output or performance.  

 

WARNING: Do not remove the instrument cover due to an electric shock hazard. For  
assistance, contact Support. 

Contacting Support 

All technical questions regarding Cellometer K2 maintenance should be directed to Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Preventive Inspection and Maintenance 

Regular preventive inspections should be carried out to reduce safety concerns of the instrument due to aging, 
normal wear and tear, etc. The manufacturer assumes no responsibility for improper changes or repairs carried 
out on the instrument or its accessories by unauthorized persons. The warranty will immediately become void 
should an unauthorized personnel attempt to in any way repair or modify the instrument.  

To schedule all preventive maintenance needs and address any functionality concerns, contact Support by visiting 
https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

STORAGE 

When preparing the instrument for storage: 

• Always thoroughly clean the instrument, cables and any of the accessories or consumables before storage.  
• Check for any damage and if possible, re-package the Instrument and Operating Computer in the original boxes.  
• Ensure that storage temperature and spatial requirements are met (see Site Preparation on page 15).  
• DO NOT put anything heavier than ≥ 25 lbs (11.3 kgs) on the instrument or the box in which it is stored. 

Store the cables neatly, checking for signs of damage or wear frequently, and immediately before/after use. Do not 
allow the cables to become kinked or tangled. Do not set heavy objects on any of the accessories or consumables.  

Note: Always store beads and reagents according to their information for use documentation. 

 
  

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Chapter 10. Troubleshooting and FAQs 

This chapter lists troubleshooting steps for resolving potential issues, common instrument messages and 
Frequently Asked Questions (FAQs).  

TROUBLESHOOTING AND INSTRUMENT MESSAGES 

Instrument cannot be powered on 

• Check to ensure Power Supply and Power Cord that were provided with the instrument are being used. 
• Check to ensure Power Supply and Power Cord are not kinked or tangled.  
• Check to ensure Power Supply and Power Cord are plugged in properly to both instrument and electrical 

outlet accordingly. 
• If Power Cord is plugged into a surge protector (recommended), be sure that surge protector is powered on.  
• Check to ensure Power Switch is in the ON position. 

Once the instrument has been powered on, confirm that light on front of the instrument (under Sample Slot) is lit. 

Operating Computer cannot connect to instrument 

• Check to ensure USB 2.0 Connector Cable that was provided with the instrument is being used. 
• Check to ensure USB 2.0 Connector Cable is plugged in properly to both Operating Computer and instrument. 
• Reboot the Operating Computer to determine if connection issue/error message is resolved. 
• If error message persists, connect a different Operating Computer to the instrument (contact Support  

for software). 
• If error message persists, reach out to Support for a replacement USB 2.0 Connector Cable or for assistance 

with re-running the camera software drivers. 

For assistance, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

Software displays “Background was saved, but … Dim XXX counts” message 

Contact Support by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

Software displays an error or hangs during image preview/acquisition 

If the software displays an error or hangs during image preview/acquisition, exit the application by closing the 
window and then re-launch the software by double-clicking the Matrix icon. If the error persists, power cycle the 
instrument and restart accessory computer. Launch the software and proceed with image preview/acquisition.  

In cases where this issue is not resolved by the procedure above or it continues to happen on a regular basis, 
contact Support by visiting https://www.revvity.com/contact-us or send email to: CellC-support@revvity.com 

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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FREQUENTLY ASKED QUESTIONS 

Can PD300 slides be used in the Cellometer K2 while using the Matrix software?  

The Cellometer K2 powered by Matrix software is designed primarily for use with SD100 and/or PD100 slides. For 
Adipocytes or other cells larger than 90 µm that need PD300 slides, use the Cellometer Image Cytometer software 
for imaging and analysis. 

How do I upgrade to the newest version of the software? 

Contact Support with the serial number of the instrument to request an upgrade. 

How do I order a replacement for an instrument Power Cord or USB 2.0 Connector 
Cable that has been lost? 

Contact Support with the serial number of the instrument to request a replacement power cord/cable. 

Why doesn’t the cell type I need appear in the Cell Type drop-down? 

Cell types can be imported from either the Revvity Cell Library or from custom libraries stored in external network 
locations. See the Matrix Software User Manual for instructions on how to import a cell library and populate the 
Cell Type drop-down menu with selected cell types. For a full list of available cell types and/or if you require a 
specific cell type, contact Support by visiting https://www.revvity.com/contact-us or send email to:  
CellC-support@revvity.com 

When testing for cell viability, why are my count results lower than expected? 

When preparing a sample to test for cell viability, ensure that the stock solution is being used as indicated in 
Trypan Blue Staining Solution Guidelines on page 27 or AO/PI Staining Solution Guidelines on page 29. Using stains 
in a concentration higher than recommended concentrations will make the cells more difficult to detect and may 
result in counting inaccuracies. 

In addition, ensure that: 

• The viability method is appropriate for the cell type. See Evaluating Viability Methods on page 27 for details.  

• The current assay and/or cell type is appropriate for the sample. See the Matrix Software User Manual for 
more information about editing assays and cell type parameter settings. 

   

https://www.revvity.com/contact-us/instrument-support-and-service
mailto:CellC-support@revvity.com
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Chapter 11. Contacting Support 

This chapter presents the scope of Support services and contact methods. In addition, it contains instructions on 
how to report issues to Support and generate diagnostic reports to assist with troubleshooting. 

SCOPE OF SUPPORT SERVICES 

Revvity is dedicated to providing our customers with outstanding support including the following services: 

• Online and in-lab customer training 
• Creation of new cell types 
• Optimization of counting parameters 
• Creation of new report templates 
• Troubleshooting via telephone 
• Periodic safety checks and functional evaluations (offered as part of a separate maintenance contract) 

To inquire about training, visit our website at https://www.revvity.com/contact-us/customer-training and choose 
the Cell Counting and Image Cytometry product. Enter your contact details and any training comments/questions. 

CONTACT METHODS 

If there is a technical issue with your instrument or software, contact Support using the following methods: 

• Visit https://www.revvity.com/contact-us/instrument-support-and-service and choose the Cell Counting and 
Image Cytometry product for support. Enter instrument serial number, name and model, your contact details, 
and a detailed description to report the issue to Support. 

• Visit https://www.revvity.com/contact-us-by-phone to find the global phone number for your area. 

• Send email to CellC-support@revvity.com 

REPORTING AN ISSUE TO SUPPORT 

If a technical issue encountered cannot be resolved using troubleshooting steps presented in this guide (see 
Troubleshooting and Instrument Messages on page 47) or if the issue persists after rebooting the instrument, 
perform the following steps before contacting Support to report the issue: 

1. Record the error message. 
2. Record the sequence of events leading up to the error, if possible. 
3. If necessary, close the error message window. 
4. Record the Serial Number located on the Device Label for your instrument.  

See Device SN Label on page 11. 

Gathering these details prior to contacting Support will be helpful as they troubleshoot the technical issue.  

https://www.revvity.com/contact-us/customer-training
https://www.revvity.com/contact-us/instrument-support-and-service
https://www.revvity.com/contact-us-by-phone
mailto:CellC-support@revvity.com
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GENERATING DIAGNOSTIC REPORTS 

To generate a diagnostic report that can be emailed to Support when experiencing a technical issue: 

1. Click the Home tab and then the About Matrix button. 

2. Click the Generate Diagnostic Report button followed by OK  
in response to the confirmation prompt. 

3. From the desktop, click the generated Diagnostic_YYYYMMDD.zip  
folder (where YYYYMMDD represents the date on which file was  
generated) to display files in the folder.  

Files in the zipped folder include logs (located in C:\logs\Matrix\vNNN where NNN represents installed version) 
and configuration files (located in C:\ProgramData\Nexcelom Bioscience\Matrix\vNNN\Configurations). 

4. Attach the zipped folder to an email, include the Support Ticket ID (if assigned) in the Subject line and send to: 
CellC-support@revvity.com 

It may be helpful to clear all logs before reproducing the sequence of steps leading up to an issue and/or to reduce 
the size of the diagnostic report to be sent to Support. Logs are generated automatically by your system on a daily 
basis. Keep in mind that clearing all logs will remove files accumulated to date for the version. 

WARNING: Logs may be required to maintain a historical archive. As using the Clear All Logs  
button will permanently remove accumulated logs for the installed Matrix software version, it  
is recommended that you contact IT before clearing logs from your system. 

To clear all logs: 

1. Click the Clear All Logs button. 

Note: It is not recommended to clear all logs unless you are  
confident that they are not being archived by your organization. 

2. When prompted, click Yes to confirm you want to clear all logs. 

3. Click OK to acknowledge that all logs have been cleared.  

 

 

  

mailto:CellC-support@revvity.com
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Appendix A. Consumables 

This appendix presents Revvity consumables designed specifically for the Cellometer K2 such as disposable 
counting chamber slides, assay reagents/reagent kits and counting beads. 

COUNTING CHAMBER SLIDES 

Cellometer Counting Chamber Slides are compatible with all Cellometer Systems. Each all plastic, disposable slide 
contains two sample counting chambers with precisely controlled height. The fixed 20 µL sample size allows for 
simple, automated calculation of cell concentration following imaging and counting. Image-based counting with 
disposable counting chambers offers several key advantages: 

• No potential clogging 
• Ideal for fragile samples, such as hepatocytes 
• No washing 
• No potential cross-contamination 

Visit the Cellometer and Cellaca Slides page on our website for a current listing or contact your Revvity Sales 
representative and to purchase Cellometer counting chamber slides directly from Revvity, Inc. 

ASSAY REAGENTS AND KITS 

Revvity provides a variety of assay reagents and reagent kits to accurately perform fluorescence-based cell 
counting and viability assays, including measuring percent viability and the number of live/dead cells. 

Visit the Reagents and Kits for Cell Counting and Cell-Based Assays page on our website for a current listing or 
contact your Revvity Sales representative to purchase Cellometer K2 assay reagents and kits directly from Revvity. 

COUNTING BEADS 

Revvity offers a wide range of brightfield and fluorescent Counting Beads that may be used to verify instrument 
functionality and establish routine quality control SOPs for daily, weekly or monthly performance. Beads are not 
intended to replace certification by Installation/Operation Qualification (IQ/OQ) procedures. 

Beads are supplied with the proper protocol, a Certificate of Analysis, and pass/fail criteria where users may 
choose to test concentration or viability read-outs on their instruments.  

Visit the Counting Beads page on our website for a current listing or contact your Revvity Sales representative to 
purchase counting beads for use with Cellometer K2 instruments directly from Revvity.  
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Appendix B. Report Designer for WPF Reference 

Revvity uses DevExpress as a third-party plugin for Matrix software reporting capabilities.  

Visit the following page on the DevExpress website for more information about creating Matrix software report 
templates using Report Designer for WPF. 

https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-wpf.html 

Sample screens displaying the range of topics available for Report Designer for WPF functionality are shown below. 

  

https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-wpf.html
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Appendix C. Warranty and License Details 

This appendix presents Warranty Information for Cellometer instruments, Revvity’s Limitation of Liability 
(Hardware and Software) statement, and Terms and Conditions related to the use of Cellometer Image Cytometer 
software, Matrix software and all related documentation. In addition, it includes a definition of Revvity’s 
Proprietary Information. 

WARRANTY INFORMATION 

Revvity warrants that Cellometer K2 instrumentation products shall, for a period of twelve (12) months from the 
date of purchase, be free of any defect in material and workmanship. The sole obligation of this warranty shall be 
to either repair or replace at our expense the product, at manufacturer’s option. The original sales receipt must be 
supplied for warranty repair. Products which have been subjected to abuse, misuse, vandalism, accident, 
alteration, neglect, unauthorized repair or improper installation will not be covered by warranty. 

Instruments must be handled and packaged correctly when shipping to other locations. Contact Revvity for 
additional information and to order packaging materials. 

Any product being returned is to be properly disinfected and packaged (in original packing if possible). Damage 
sustained in shipping due to improper packing will not be covered by warranty. 

TERMS AND CONDITIONS 

The Revvity, Inc. – Terms and Conditions of Sale license agreement states the terms and conditions upon which 
Revvity offers to license to you the software together with all related documentation. The Software is licensed to 
you for use only in conjunction with Revvity’s family of products. 

In addition, the original Cellometer Image Cytometer software, Matrix software and any subsequent software 
upgrades installed on your Cellometer system by authorized representatives of Revvity, Inc. is protected. You may 
not tamper with this software (including unauthorized upgrades), disclose it to third parties or use it for any 
purpose other than running your Cellometer system. Revvity does not grant you any other rights to use or disclose 
the original Cellometer Image Cytometer software, Matrix software or subsequent upgrades, and any further uses 
will be prosecuted by Revvity, Inc. to the maximum extent possible by law. Any other use of Cellometer Image 
Cytometer software, Matrix software or upgrades is explicitly prohibited. In addition, you may not disclose 
Cellometer Image Cytometer software, Matrix software, upgrades, or any of its features and benefits to a third 
party. 

Revvity Proprietary Information 

Cellometer K2 products have been developed by Revvity and include certain intellectual property of Revvity, 
including without limitation, software, samples, schematics, specifications, manuals, designs, and other technical, 
business, trade secret, proprietary and confidential information provided to Buyer by Revvity (“Revvity Proprietary 
Information”).  
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Buyer is granted a non-exclusive right and license to use the Revvity Proprietary Information solely: (a) as 
incorporated into, and in conjunction with, the products, (b) in conformance with the specifications, and (c) for 
Buyer’s internal use.  

Buyer may not: (i) assign, sublicense, transfer, lease, rent or distribute any of its rights in the Revvity Proprietary 
Information; (ii) port, translate, localize or create derivative works based upon the Revvity Proprietary Information 
in any manner; (iii) reverse assemble, decompile, reverse engineer, translate or otherwise attempt to derive or 
obtain the source code, the underlying ideas, algorithms, structure or organization of the Revvity Proprietary 
Information; (iv) use the Revvity Proprietary Information for the benefit of any third party including as part of any 
service bureau, time sharing or third party training arrangement; or (v) publish any benchmark testing results on 
any product or the Revvity Proprietary Information without Revvity’s written consent.  

Revvity retains all ownership rights in the Revvity Proprietary Information and, other than limited license set forth 
in this section, Buyer shall have no right in or to the Revvity Proprietary Information.  

Buyer will not disclose the Revvity Proprietary Information to any third party or use it in any manner outside the 
scope of the license including: (1) developing, designing, manufacturing, engineering, reverse engineering, 
refurbishing, selling or offering for sale items, parts or components of items, derivatives of or equivalents, or  
(2) assisting any third party in any manner to perform such activity.  

Buyer shall use reasonable care to protect the Revvity Proprietary Information, and in no event less than the care 
Buyer uses to protect its own like information.  

LIMITATION OF LIABILITY (HARDWARE AND SOFTWARE) 

Cellometer® automated cell counting instruments, software and consumables are intended for research use only. 

In no event shall Revvity be liable for any damages whatsoever (including, without limitation, incidental, direct, 
indirect, special or consequential damages, damages for loss of business profits, business interruption, loss of 
business information) arising out of the use or inability to use this Software, Consumables or related Hardware. 
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